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Preface 

This Preface introduces the guides and other information sources available to help 

you more effectively use Oracle Fusion Applications. 

An Oracle Enterprise Governance, Risk and Compliance (GRC) platform hosts sev-

eral products — Oracle Application Access Controls Governor (AACG), Oracle Enter-

prise Transaction Controls Governor (ETCG), and Oracle Enterprise Governance, 

Risk and Compliance Manager (EGRCM). 

The GRC platform runs modules. “Financial Governance” is the name of an EGRCM 

module, and users may create other EGRCM modules. “Continuous Control Monitor-

ing” (CCM) is the name of the module in which AACG and ETCG run. (Moreover, 

GRC “Tools” offer functionality used across GRC modules.) 

This Enterprise Transaction Controls Governor User Guide covers features specific 

to ETCG. (Other product-specific user guides cover features particular to AACG 

and to EGRCM.) 

An Enterprise Governance, Risk and Compliance User Guide covers most function-

ality common to the GRC applications (although the Enterprise Governance, Risk 

and Compliance Installation Guide covers some setup and administration topics). 

Refer to these guides as well as the ETCG user guide as you use ETCG. 

Additionally, implementation guides discuss concepts you should consider as you 

set up GRC products for use. One implementation guide exists for each of AACG, 

ETCG, and EGRCM, and a distinct implementation guide covers GRC security. 

Consult these documents as you begin to use GRC. 

Disclaimer 
The information contained in this document is intended to outline our general 

product direction and is for informational sharing purposes only, and should be 

considered in your capacity as a customer advisory board member or pursuant to 

your beta trial agreement only. It is not a commitment to deliver any material, code, 

or functionality, and should not be relied upon in making purchasing decisions. The 

development, release, and timing of any features or functionality described in this 

document remains at the sole discretion of Oracle. This document in any form, 

software or printed matter, contains proprietary information that is the exclusive 

property of Oracle. Your access to and use of this confidential material is subject to 

the terms and conditions of your Oracle software license and service agreement, 
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which has been executed and with which you agree to comply. This document and 

information contained herein may not be disclosed, copied, reproduced or 

distributed to anyone outside Oracle without prior written consent of Oracle. This 

document is not part of your license agreement nor can it be incorporated into any 

contractual agreement with Oracle or its subsidiaries or affiliates. 

Other Information Sources 

My Oracle Support 

Oracle customers have access to electronic support through My Oracle Support. For 

information, visit http://www.oracle.com/support/contact.html or visit 

http://www.oracle.com/accessibility/support.html if you are hearing impaired. 

Use the My Oracle Support Knowledge Browser to find documents for a product area. 

You can search for release-specific information, such as patches, alerts, white papers, 

and troubleshooting tips. Other services include health checks, guided life cycle advice, 

and direct contact with industry experts through the My Oracle Support Community. 

Oracle Enterprise Repository 

Oracle Enterprise Repository provides visibility into service-oriented architecture 

assets to help you manage the life cycle of your software from planning through 

implementation, testing, production, and changes. In Oracle Fusion Applications, 

you can use the Oracle Enterprise Repository for: 

• Technical information about integrating with other applications, including ser-

vices, operations, composites, events, and integration tables. The classification 

scheme shows the scenarios in which you use the assets, and includes diagrams, 

schematics, and links to other technical documentation. 

• Publishing other technical information such as reusable components, policies, 

architecture diagrams, and topology diagrams. 

The Oracle Fusion Applications information is provided as a solution pack that you 

can upload to your own deployment of Oracle Enterprise Repository. You can doc-

ument and govern integration interface assets provided by Oracle with other assets 

in your environment in a common repository. 

Documentation Accessibility 
For information about Oracle’s commitment to accessibility, visit the Oracle Acces-

sibility Program website at http://www.oracle.com/us/corporate/accessibility 

/index.html. 

Comments and Suggestions 
Your comments are important to us. We encourage you to send us feedback about 

Oracle Fusion Applications Help and guides. Please send your suggestions to 

oracle_fusion_applications_help_ww@oracle.com. You can use the Send Feedback 

to Oracle link in the footer of Oracle Fusion Applications Help. 
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1 

Introduction 

Oracle Enterprise Transaction Controls Governor (ETCG) evaluates transaction risk 

in Oracle E-Business Suite and PeopleSoft. ETCG implements “models” and “contin-

uous controls” that specify circumstances under which individual transactions display 

evidence of error, fraud, or other risk. 

ETCG is one of a set of applications, known collectively as “Oracle Advanced Con-

trols,” that regulate activity in business applications. Together with another Advanced 

Controls application — Application Access Controls Governor — ETCG runs as a 

Continuous Control Monitoring (CCM) module in an Enterprise Governance, Risk 

and Compliance (GRC) platform. 

ETCG Models and Controls 

An ETCG model returns “temporary” results — a snapshot of risk that is replaced 

each time the model is evaluated. A continuous control returns “permanent” results 

— records of violations that remain available to be resolved no matter how often the 

control is run. 

A user creates a model, and may then convert the model into a control; users cannot 

create controls directly. Although the creation of a model is a preliminary step in the 

creation of a control, models may be created to run on their own, so that users such 

as auditors can assess the risk inherent in a system at a given moment. 

An ETCG model or control specifies circumstances under which transactions entail 

risk and so require review. A model, or the control into which the model is converted, 

consists of one or more elements — “filter,” “function” or “pattern.” Each, in a dis-

tinct way, defines an aspect of the risk a transaction may present and captures records 

of transactions that meet its definition. 

Each of these elements may cite a “business object” and an “attribute” of that 

object, which supply transaction data for analysis. A business object is, in effect, a 

set of related data fields from an ERP application subject to GRC analysis, and an 

attribute is one field within the set.  

Filters may also cite other object types: A “custom” object is a set of data imported 

from an xml file. A “system-generated” object is data returned by certain transaction 

filters. A “user defined” object is data returned by a specially configured continuous 

control; each of its result columns constitutes an attribute of the object.  
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There are two types of ETCG control or model: 

• A “Defined” control or model contains filters or functions. These elements en-

able the user creating a model to define circumstances under which transactions 

are considered to pose a risk. A model or control can incorporate any number of 

filters or functions. 

For example, a model may include two filters, both based on a Payables Invoice 

business object. One filter would select transactions for which an Invoice Can-

celed Date attribute is not blank. From the transactions captured by the first filter, 

the second would select those for which an Amount Paid attribute is not equal to 

zero. The model would therefore identify invoices on which payments had been 

made even though the invoices had been canceled. 

• A “Pattern” control or model contains a pattern — an Oracle-supplied statistical 

function that identifies a baseline set of transactions, then uncovers outliers to 

the baseline, as a way of discovering unknown risk. A control or model can use 

only one pattern (which can be combined with any number of filters or functions). 

Records of control violations are known as “incidents,” and each control names one 

or more GRC users as “result investigators” who are responsible for resolving incidents. 

Users may create perspectives, each of which is a set of hierarchically arranged val-

ues. Each represents a context in which models, continuous controls, and incidents 

exist. Users can relate individual perspective values to individual models, controls, 

or incidents, thus cataloging them by organization, region, or any other concept the 

company finds meaningful. Perspective values also play a part in GRC security. In 

particular, perspective values associated with controls or incidents determine which 

users are eligible to be result investigators — those assigned data roles with match-

ing perspective values. 

Incident Analysis 

Typically, continuous controls generate incidents when they are run (although spe-

cially configured controls may compile datasets for user defined objects). Each 

ETCG incident provides a record of a transaction that exceeds the risk defined by a 

control. Each record is made up of values for attributes selected for the model that 

served as the basis for the control that generated the incident. 

Each incident identified by an ETCG control defaults to an Assigned status. This 

means that result investigators are assigned to address the incidents generated by a 

control. The investigator might: 

• Look at the incidents generated by a control, decide that nothing need be done 

to resolve them, and change status to Accepted. 

• Look at the incidents generated by a control, decide that something must be 

done in the business-management application to resolve them, and change status 

to Remediation. For an ETCG incident, remedial action typically involves deter-

mining whether a suspect transaction is in fact erroneous, fraudulent, or other-

wise damaging, and if so, correcting the situation. 

• In this second case, ensure that appropriate action has been taken in the business-

management application, and update status from Remediation to Resolved. 
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In addition to the Assigned, Accepted, Remediation, and Resolved statuses, GRC 

may automatically assign a Control Inactive status, which means that an incident is 

no longer of concern because the control that generated it has been inactivated.  

(Each incident has not only status, but also one of three states: In Investigation, 

Approved, or Closed. These are assigned by GRC. See “Resolving Incidents,” page 

4-1.) 

Reporting 

Users can run reports concerning ETCG, its companion applications, and GRC 

administration. Those that apply to ETCG include summary and detail reports about 

transaction controls and about the incidents they identify. 

Some reports can be run “contextually” — from pages in which controls are managed 

or incidents are resolved. Contextual reporting is discussed on pages 3-6 and 4-7 of 

this document. 

All reports can be run from Report Management pages. Because Report Management 

features are common to all GRC applications, they are discussed in the Enterprise 

Governance, Risk and Compliance User Guide.  

Common Procedures 

As you work with ETCG models, controls, and incidents, you may perform certain 

procedures that are common to GRC applications. You may use a home page or 

overview pages to view worklists (records of tasks requiring action on your part) and 

notifications (records of tasks in which you have an interest, but which do not require 

you to act). You may use navigation features to move among GRC application pages. 

You may use search features to filter lists of records. You may set “user preferences” 

— review and edit information about your user account. For complete information on 

these features, see the Enterprise Governance, Risk and Compliance User Guide. 

Descriptions of other common procedures follow. 

Selecting Perspectives 

You can assign perspective values to models, continuous controls, and incidents 

generated by controls. These may serve as filtering values in the management pages 

for these objects, or in reports. They also play a part in determining which users 

have access to any of these objects — those whose job roles contain data roles 

associated with perspective values that match the values selected for the object. 

(Users must also have duty roles granting privileges to work with the object.) 

Although perspective hierarchies are created in Perspective Management, each 

hierarchy becomes available for use with models, controls, or incidents only after 

being associated with that type of object in Manage Module Perspectives. In the pages 

for creating, editing, or resolving these objects, a Perspective Assignment panel dis-

plays a tab for each perspective hierarchy that has been associated with the object. 

In Manage Module Perspectives, a perspective may be designated as required for 

the object with which it is being associated. If so, the tab that displays its name also 
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displays an asterisk; a user is unable to save an instance of the object if he does not 

select a value for the required perspective. 

When you create or edit models, create controls or edit them individually, or edit 

incidents individually, you select a set of perspective values for the object with which 

you are working. When you “mass edit” controls or reassign a set of incidents, you 

select perspective values to be added to, or removed from, the values already selected 

for each of the objects with which you are working. 

To select perspective values: 

1. Click on the tab for the perspective hierarchy from which you want to select 

values. 

2. If you are editing two or more selected controls at once, or assigning two or 

more selected incidents simultaneously, select an Add or Remove radio button 

to indicate whether you are adding values to, or removing them from, values 

already selected for the objects with which you are working. (If you are creating 

objects or editing them individually, this step does not apply, and the radio 

buttons do not appear.) 

3. Choose values to move between Available Perspectives and Selected Perspec-

tives lists. (Ultimately, those in the Selected Perspectives list are assigned to 

individually configured objects, or added to or removed from those already 

assigned to mass-edited objects.) In either list, locate a perspective value you 

want to move from one list to the other. Do either of the following: 

• Click on the plus sign next to the root node to expose perspective values at 

the next hierarchical level. Click on a plus sign next to a node at that level 

to reveal its child nodes. Continue until you reach the node you want. 

(For incidents only, you may also select View > Expand All to display, and 

choose from, all nodes configured for the perspective. Other View options 

enable you to collapse the entire hierarchy, expand or collapse nodes beneath 

a selected node, display only a selected node and those that descend from it, 

and scroll to the first or last node.) 

• Type a text string in the search box to produce a list of matching 

perspective-value names. You can use the percent sign (%) as a wild-card 

character; entries are not case-sensitive. A search returns only matching 

perspective values; it does not display an entire perspective hierarchy. 

If you are assigning perspective values to models or controls, you can choose 

them only one at a time; click on the value you want. If you are assigning per-

spective values to incidents, you may choose one value by clicking on it; choose 

a continuous set by clicking on the first, holding down the Shift key, and click-

ing on the last; or choose a discontinuous set by holding down the Ctrl key as 

you click on values. 

4. Click the > button to cause values chosen in the Available list to appear in the 

Selected list. Or, click the < button to remove values chosen in the Selected list 

from that list. 

(Alternatively, click the >> button to place all perspective values in the Selected 

list, or the << button to remove all values from that list.) 

5. Repeat steps 1–4 to select any number of perspective values from any number 

of hierarchies. 
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As you assign perspective values to incidents, you may also select a View Perspec-

tive button to see a representation of the full hierarchy from which you are selecting 

a value. Click on any value, and a Related Components panel opens, displaying ob-

jects with which the value is associated. (This feature is not available as you assign 

perspective values to models or controls.) 

Synchronizing Data 

Models and controls evaluate transactions completed in datasources (instances of 

business-management applications). It’s assumed that a set of datasources is configured 

for your ETCG instance. (See the Enterprise Governance, Risk and Compliance User 

Guide.) 

To ensure models and controls evaluate current data, run synchronization — a pro-

cess that copies data from datasources to ETCG. An ordinary synchronization run is 

incremental — it creates or updates only records that are new or have changed since 

the previous synchronization. 

Distinct processes synchronize transaction and access data. In most cases, you need 

synchronize only transaction data before evaluating transaction models or controls. In 

certain cases, however, you need to synchronize access data as well: If you intend to 

evaluate a transaction model or control that incorporates the User business object, or 

that contains filters that specify “who attributes” that return names. The latter identify 

users who complete actions in the target application, such as the Created By Name 

attribute of the Supplier business object. (“Who attributes” that return user IDs, how-

ever, do not require access synchronization.) 

ETCG distinguishes among three categories of business object — Transaction (in 

which records are created or updated frequently), and Operational and Configuration 

(consisting of master-data or setup records that change infrequently). If a Graph Syn-

chronization Date Limit is set, the synchronization of Transaction business objects 

operates only on records created or updated in datasources after a specified date. Older 

Transaction records remain as they were in the GRC database. (For Operational and 

Configuration business objects, however, a synchronization run encompasses all rec-

ords, regardless of when they were created or updated.) The Date Limit is specified 

in the Manage Application Configurations page; see the Enterprise Governance, Risk 

and Compliance User Guide.  

You have two synchronization options. One is to synchronize the data used only by 

an individual model (see “Model-Data Synchronization” on page 2-2).  

The other is to synchronize data supporting business objects used by all the models 

and controls configured to evaluate risk on a selected datasource. To use this option:  

1. Open a Manage Application Datasources page: select Setup and Administration 

under Tools in the Navigator, then Manage Application Datasources under Setup. 

2. Select the row for the datasource for which you want to synchronize data. 

3. Do one of the following: 

• Click on Actions > Synchronize Transaction. This causes ETCG data to be 

synchronized once, immediately. (Before you can synchronize transaction 

data, at least one transaction model must exist.) 
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• Click on Actions > Synchronize Access. This causes all access data to be 

synchronized once, immediately. (You can synchronize access data even if 

no models or controls yet exist.) 

• Click on Actions > Schedule Synchronize. A Schedule Parameter dialog 

opens; in it, you may create a schedule on which any number of synchroni-

zation operations run automatically. Select the Transaction or Access check 

box, or both, and enter values that set the name of the schedule, its start date 

and time, the regularity with which the synchronization should occur, and 

an end date (if any). Then click on the Schedule button. 

Although an ordinary synchronization run is incremental, you can instead “rebuild 

the graph” — delete all data for a given datasource and replace it with a complete 

set of current data. This typically takes longer than an ordinary synchronization, and 

it potentially has a significant effect on existing incidents, model results, and worklists. 

As a result, a graph rebuild should not be performed frequently. To rebuild the graph, 

open the Manage Application Datasources page and select the row for a datasource. 

Then select Actions > Rebuild Graph, and click the OK button in a confirmation 

message that appears. 

Attaching Files 

In the pages in which you edit incidents, you can attach files to them. An attachment 

may, for example, be a text file, spreadsheet, or web site that provides more informa-

tion about an object than can be contained in its Description field. 

For most attachments, you need to specify a content type. These values are config-

ured in Manage Content Types, which is available in the Setup and Administration 

tasks. If no existing content type is appropriate for your attachment, have one cre-

ated in Manage Content Types. (See the Enterprise Governance, Risk and Compli-

ance User Guide.) 

To attach a file: 

1. Click on the green plus sign next to the Attachment label in a create or edit 

page. An Attachments pop-up opens. 

2. Select Actions > Add. A new row appears. 

3. Select a Type — desktop file or url. (During a mass update of incidents, only 

the url type can be attached.) 

4. If you select desktop file, click the browse button to navigate to, and select, the 

file you want. Select a content type, compose a title, and optionally enter a descrip-

tion. If you select url, enter it in the File Name/URL field, compose a title, and 

optionally enter a description. (Content type does not apply in this case.) 

5. If you wish to create additional attachments, repeat steps 2 through 4 for each 

attachment. 

6. Click the OK button to exist the Attachments pop-up. 

You can also delete an attachment by opening the Attachments pop-up, selecting a 

row, and selecting Actions > Delete. 

To view an attachment, click on its name in the management, creation, or edit page 

for an object. 
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Importing and Exporting Models and Controls 

You can export models and controls from a source instance to a file, or import them 

from a file to a destination instance. However, several rules apply: 

• “Seeded content” is a set of models (but not controls) developed by Oracle for 

use with GRC. A version of seeded content is released with each GA release of 

GRC. That version of seeded content can be imported into the GA release or 

any patch to that release. 

• Models and controls exported from an instance of a GA release can be imported 

into any patch for that release (but not from one patch to another, or one GA release 

to another).  

• Models and controls exported from a GRC instance at any particular version can 

be imported into another instance at the same version. 

To export models or controls: 

1. In the Manage page for models or controls, select items to export. To select one, 

click on it. To select a continuous set, click on the first, hold down the Shift key, 

and click on the last. To select a discontinuous set, hold the Ctrl key as you 

click on models or controls. 

2. Click on Actions > Export. An Information pop-up window opens, identifying a 

job number. Note the number, then close the window (click on its OK button). 

3. Using the Navigator, go to Tools > Setup and Administration > Manage Jobs. 

the Manage Jobs page, locate the row displaying the job ID you noted in step 2. 

When its Message cell displays a Job Completed link, click on the link. 

4. A Job Detail window opens. In it, click on the Item Results link. 

5. A file-download window offers you options to open or save the export file. The 

precise behavior of this window depends on the web browser you use, but in 

general, select the Save option and, in a distinct save-as dialog, navigate to the 

folder in which you want to save the file. The file is saved in .xml format. The 

first word of its name —Models or Controls — identifies its content. 

6. Close the Job Detail window (click on its OK button). 

Models and controls may specify perspective values, and upon import are available 

to users whose data roles are associated with those perspective values. (Before im-

porting, be sure the perspectives are set up in the target instance.)  

To import: 

1. Return to the Manage page for the item you are importing — models or 

controls. 

2. Click on Actions > Import. 

3. An Import File pop-up window opens. Click on its Browse button. 

4. A Choose File dialog opens. In it, navigate to, and select, the .xml file you want 

to import. The path and name of the file then populate the field next to the Browse 

button in the Import File window. 

5. Click on the OK button in the Import File window. 
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6. A Select Items to Import window lists the items contained in the import file. 

Select those you wish to import, bearing in mind that you can import only those 

items that use business objects to which your GRC roles grant you access. To 

select one item, click on it. To select a continuous set, click on the first item, 

hold down the Shift key, and click on the last. To select a discontinuous set, 

hold down the Ctrl key as you click on items. 

7. Click on the Next button. An Import Datasource Mapping window opens, dis-

playing one row for each datasource specified in the items you’ve chosen to im-

port. For each, in a Mapped Datasources list box, select a datasource appropri-

ate for the environment into which you are importing the models. (The list box 

displays datasources configured in the GRC Manage Application Datasources 

page, to which your GRC roles provide you access.) 

8. Click on the Import button. A pop-up message reports the number of items 

imported and the status of the import operation. Click on its × button to close it. 

A model or control may cite a user defined object — data generated by a specially 

configured “dataset” control. Exporting a model or control that cites a user defined 

object, and importing it to another instance, involves some special considerations: 

1. Export the dataset control (the one that generates data for the user defined object) 

from the source instance. 

2. Export the model or control that cites the user defined object. 

3. Import the dataset control into the destination instance, and manually run it 

there (see “Running Controls” on page 3-5) to generate an initial dataset. 

4. In the destination instance, manually create the user defined object (see “Man-

aging User Defined Objects” on page 3-6). Ensure that its name is identical to 

that of the user defined object from the source instance. 

5. Import the model or control that cites the user defined object into the destination 

instance. 
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2 

Creating and Managing Models 

A transaction model defines circumstances under which transactions in business-

management applications might involve error or fraud, or otherwise entail risk. It 

may employ filters, functions, or a pattern. 

• A standard filter specifies an attribute of a business object (or of a custom, 

system-generated, or user defined object). It compares the values for that attrib-

ute with a fixed value or with the values for another attribute. It includes a “con-

dition” that determines how the comparison is made, and it returns records of 

transactions for which the comparison is true. For example, a filter may state 

that payment amount (an attribute of the Payment business object) is greater 

than (condition) a threshold amount (fixed value). 

A filter may also arrange records of transactions into groups, based on common-

ality in the values of an attribute. It may, for example, find invoices with similar 

vendor names, to identify duplicate invoices in which the vendor’s name is ren-

dered slightly differently. 

• A function, like a filter, creates a formula consisting of an attribute, a condition, 

and a comparison value, but it also incorporates a function that operates on the 

attribute term, for example taking the average of a set of attribute values. It also 

uses the grouping capability to establish sets of records on which the function 

operates. For example, a function might group records by supplier, calculate an 

average payment amount for each supplier, then determine whether each aver-

age amount exceeds a threshold value. 

• A pattern employs a statistical function, provided by Oracle, that identifies 

baselines and outliers to those baselines. 

Managing Models 
A Manage Transaction Models page provides information about models to which 

your data roles give you access. Within that limitation, you can view and work with 

models created by any user — create or modify models, view or export results, or 

export and import models (page 1-7). To open the page, select Manage Transaction 

Models from among the Continuous Control Management tasks available from the 

Navigator.  
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Viewing Models 

In the Manage Transaction Models page, a “Manage Models” grid displays a list of 

transaction models if you select Manage Transaction Models in the Tasks list (or 

access models if you select Manage Access Models in the Tasks list).  

The page displays summary information for each model it lists. This information is 

supplied by GRC, from data recorded when a model is created, edited, or run; you 

cannot update these records directly. 

Among the summary values, the model type may be Transaction—Defined (the 

model contains user-defined filters or functions) or Transaction—Pattern (the model 

contains a pattern, but may also contain filters or functions). A third type, Access, 

applies to models created in Application Access Controls Governor.  

Model status indicates whether the model has been evaluated and has produced results 

— records of transactions it has found to be risky. Values include Not Started, Started, 

Completed, and Canceled. In addition, an Error status links to the GRC Jobs page, 

which can provide information about processing errors. Model state is either Approved 

or Invalid (the latter state applying only to models that are not imported correctly 

during an upgrade from an earlier version).  

Creating, Editing, Copying, or Deleting Models 

To create a model, select a Create Transaction Model option, which is available 

both in the Actions menu of the Manage Transaction Models and among the Con-

tinuous Control Management tasks available from the Navigator. Either selection opens 

a Create Transaction Model page (see “Creating an Transaction Model,” page 2-3). 

To edit a model, click in the Manage Models grid on the row for the transaction 

model you want to edit. Then click on Actions > Edit. This opens an Edit Transac-

tion Model page — a replica of a model-creation page, except that it is populated by 

values for the model you want to edit. 

Rather than create a model from scratch, you can copy an existing model, then mod-

ify the copy. To do so, select (click on) the model you want to copy. Then select 

Actions > Copy. A new row appears in the Manage Models grid, identical to the 

listing for the copied model except that the model name ends in a number in paren-

theses. (The value of the number depends on how often you copy the original.) Once 

the copy exists, you can select Actions > Edit to modify the model as you please. 

To delete a model, click in the Manage Models grid on the row for the model you 

want to delete. Then click on Actions > Delete, and respond to a message that asks 

you to confirm the deletion. 

Model-Data Synchronization 

From the Manage Transaction Models page, you can select a model and synchronize 

the data it uses. This process loads data only for business objects (cited in the selected 

model) that have never been synchronized before. So this synchronization option 

enables you to add new objects as you create or edit a model, and then load the data 

you need to test that model.  

1. In the Manage Models grid, select (click on) the row for a model whose data 

you want to update. 
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2. Select Actions > Synchronize. 

3. A message displays a job number; note the number, then  close the message 

(click on its OK button).  

4. To check on the status of the synchronization job, navigate to Tools > Setup and 

Administration > Manage Jobs. In the Manage Jobs page, locate the row display-

ing the job ID you noted in step 3. Click on the link in its Message cell.  

From a Manage Application Datasources page, you can instead synchronize all 

transaction data from a datasource at once. See “Synchronizing Data” on page 1-5.  

Creating a Transaction Model 

To create a transaction model: 

1. Open the Create Transaction Model page: Click on Actions > Create Transac-

tion Model in the Manage Transaction Models page (see page 2-2). Or, select 

Create Transaction Model under Control Management in the Tasks panel.  

2. Name and describe the model (see below). If an analysis time limit has been set, 

choose whether to accept or disable it for this model. 

3. Select business objects (page 2-4) and datasources (page 2-6) which, in combi-

nation, determine the data available for a model to evaluate. You may use cus-

tom objects (page 2-5), system-generated objects (the results of filters that gen-

erate sets of values; page 2-14), or user defined objects (the results of specially 

configured controls; page 3-6) as if they were business objects. 

4. Create filters, functions, or a pattern. As you create them, arrange their vertical 

and horizontal alignment to one another, to set the order in which they are to be 

evaluated (pages 2- 7 through 2-18). 

5. Select perspective values for the model (page 1-3). 

Each model is automatically assigned values for CCM Type, Business Object, 

Datasource, and potentially User Defined Business Object  system perspectives. 

These values represent selections you make as you create the model — whether 

it is an access or transaction model, and the datasources and objects you select 

for it. So at minimum, a model is restricted to users whose data roles include 

matching values for system perspectives. You can assign other perspective values, 

further restricting the model’s availability. Perspective values associated with a 

model also apply to any control developed from the model. 

6. Define model results (page 2-18), and save the model (page 2-19). 

Naming the Model 

Near the top of the Create Transaction Model page, locate the Name field. Click in 

it, and type a name for your model. Then click in the Description field immediately 

below the Name field, and enter a brief explanation of the purpose for the model. 

Alongside the Name field, a Datasource field displays the datasources that are 

subject to the model you create. Initially, the field may display a default datasource 

(if one is specified in the Manage Application Data page). You can add datasources 

to the model, or delete datasources (including the default datasource), but you do so 

elsewhere. GRC updates the Datasource field, and you cannot do so directly. 
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Choosing Whether to Limit Analysis Time 

An Enforce Allocated Analysis Time Per Filter feature may be enabled in the 

Properties tab of the Manage Application Configurations page. (See the Enterprise 

Governance, Risk and Compliance User Guide.) If so, an Allocated Analysis Time 

Per Filter checkbox is selected by default in the Create Transaction Model page. You 

can disable this feature for the model you are creating by clearing the check box.  

When this feature is activated, each filter you create for the model runs for no longer 

than a number of minutes displayed in the checkbox label. If time expires, the filter 

passes records it has selected to the next filter for analysis, but ignores records it has 

not yet examined. In this case, the filter may not capture every transaction that meets 

its definition, and the results returned by the model are labeled “partial” in GRC 

job-management pages.  

When the Allocated Analysis Time feature is disabled, each filter evaluates all appro-

priate records, no matter how long that takes.  

The number of minutes per filter is set in the Properties tab of the Manage Applica-

tion Configurations page; it cannot be changed in the Create Transaction Model page. 

Moreover, if the feature is not enabled in the Properties tab of the Manage Applica-

tion Configurations page, the Analysis Time checkbox on the Create Transaction 

Model page is cleared by default, and cannot be selected. 

Selecting Business Objects 

Select one or more business objects. Each corresponds to one or more database 

tables, existing in one or more datasources, that hold information pertinent to trans-

actions, but each is given a business-language name that evokes the UI screen its 

tables support, and in which transactions may be completed. In place of a business 

object, you may select a custom object (page 2-5), system-generated object (page 2-

14), or user defined object (page 3-6). 

To add business objects to a model: 

1. In a grid at the left of the Create Transaction Model page, select (click on) the 

Business Objects tab, and then on an object in the grid. (Although unlabeled, 

this grid is known as “the Library.”) 

2. Do either of the following: 

• In the Library, click on the Add to Model button. The selected business 

object appears in the panel labeled “Model Objects.” 

• Use your mouse to drag the business object to the area labeled “Add Object 

Here” in the Model Objects panel. 

3. Repeat this process if you wish to add more objects to the model. 

Within the Model Objects panel, each business object appears as a window in which 

you can view, but not actually select, the attributes of the object. You can also: 

• View the synchronization cutoff date, if a Graph Synchronization Date Limit is 

set (see “Synchronizing Data” on page 1-5). To do so, place the mouse cursor over 

the title bar for a Transaction business object. If no Graph Synchronization Date 

Limit is specified, the value No Date Limit appears. That value also appears if 

you place the mouse cursor over the title bar for an Operational or Configura-



 

 Creating and Managing Models 2-5 

tion business object, regardless of whether a Graph Synchronization Date Limit 

is specified. 

• Remove a business object from the model: click on its × button. 

• Move a business object to the left or right of other objects: Click on the 

downward-pointing, green triangle. Two options appear; click on either Move 

Left or Move Right. 

• Create custom attributes. Each specifies an existing attribute and combines its 

values with a fixed value or with the values for another attribute.  

1. Click on the green + icon. An Add Custom Attribute dialog opens. 

2. In an Attribute Name field, create a name for the new attribute. 

3. In a Base Attribute field, select one of the existing attributes. 

4. In a Modifier field, select a mathematical operator: + (addition),  

– (subtraction), * (multiplication), / (division), or & (creates a comma-

delimited text string of the combined values). You are able to select only 

among modifiers appropriate for the base attribute selected in step 3. For 

example, you can subtract dates, but you cannot multiply them. 

5. In a Type field, select Value or Object. 

6. If you selected Value, enter a value to be combined with the base attribute, 

as defined by the modifier. 

If you selected Object, select a second attribute, whose values are combined 

with those of the base attribute, as defined by the modifier. 

7. Click on the OK button. 

You can use the custom attribute in filters. Custom attributes appear at the top 

of the list of attributes displayed by the business object, and each has an edit 

icon (which looks like a pencil). You can click on a custom attribute to open 

another dialog box in which you may either edit or delete the custom attribute. 

Using Custom Objects 

For transaction models, you can import any set of data as a “custom object,” and use 

it as if it were a business object. For this purpose, you can import xml files or zip 

compressions of xml files. The maximum size for an import file is 2 gigabytes. As 

you create an xml file, observe the following formatting conventions: 

• The first row of the file must be column headers. Each header name serves as an 

attribute of the object. Each header entry must comprise a name and, in parentheses, 

a data type — for example NAME(String), IDNUMBER(Integer), DATE(Date) or 

AMOUNT(Double). 

• The second row and beyond are considered its values. 

• The file should contain only one sheet. Multiple sheets are not supported. 

• Before the file is uploaded, the following format conversions must be made: 

– Convert computed values to absolute values. 

– Remove “total” amount rows not directly tied to specific data attributes. 
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– Numeric formatting, such as $ signs, is not supported. The format should be 

changed to Number format. 

– To format negative amounts, use a negative sign, –, not parentheses. 

– Date format is mm/dd/yyyy. 

– Excel 2003 and later are supported. (You can take an xls file as the 

datasource, properly format it to support upload to GRC, and perform a 

Save As operation to convert it to an xml file.) 

A filter may contain an Expresses condition, which determines whether text fields in 

a specified business (or custom) object contain any term in a custom dictionary. For 

this condition to be used, the dictionary must be created as a custom object.  

• At minimum, the object must contain a Word attribute (String format) and a 

Relevance attribute (Double format). The Word attribute lists terms for which 

the Expresses condition searches. The Relevance attribute rates their relative 

importance. You may include other attributes as well (which, along with the 

Relevance attribute, may be selected for the results displayed for incidents 

generated by a model or control that uses the Expresses condition).  

• An “Include Empty Row” advanced option is available to the Expresses condi-

tion. For it to be useful,  include one row in the custom object in which the Word 

value is null and the Relevance value is 0.  

If you choose to refresh an existing custom object, the new file must use the exact 

format of the original. Columns (attributes) can neither be added nor deleted. Only 

additional rows of values can be added.  

To upload a custom object: 

1. Click on Custom Objects > Import in the Library for the Create Transaction 

Model page. An Import File dialog opens. 

2. Create a name for the object in the Name field. This is the object name the 

Library will display. 

3. In a Type field, select a label that characterizes the content of the custom object 

— for example, Financials or Procurement. 

4. Click the Browse button. A Choose File dialog opens. In it, navigate to, and 

select, the xml or zip file you want to import. The path and name of the file 

populate the field next to the Browse button in the Import File window. 

5. With the file selected, click on the OK button. The custom object is now 

available for use as if it were a standard business object. 

To delete a custom object, select it in the Library. Then select Custom Objects > 

Delete, and respond to a prompt to confirm your deletion. 

Selecting Datasources 

Before a business (or other) object can supply transaction data to a model, it must be 

associated with at least one datasource. As the model is evaluated, a filter citing that 

business object will analyze data from the associated datasource.  

In most cases, a datasource is an instance of a business application that is subject to 

GRC analysis. Connections to these datasources are configured in a Manage Applica-
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tion Datasources page. In addition, a datasource called Grc corresponds to the GRC 

instance in which you are working, and it exists automatically. If you select a User 

or Access Entitlements business object, or any user defined object, you must associate 

the Grc datasource with it. Additionally, an XLS datasource is selected for custom 

objects. 

In the Manage Application Datasources page, one datasource may be designated as 

default. If so, that datasource is associated with any business object (other than User 

or Access Entitlement) as soon as you select it for a model. (No matter whether a 

default datasource has been configured, you must actively select the Grc datasource 

for the User or Access Entitlements business object, or for any user defined object.) 

As you add business objects to a model, you can change, or add to, their default 

datasource selection. If no default datasource has been designated, you can add 

datasources to each business object. To do so: 

1. When you add a business object to the Model Objects panel, a Manage Data-

source button becomes active. Click on it. A Manage Datasource window opens.  

2. To add a datasource, create a new row: click on Actions > Create New, or on 

the green + sign. (You can have multiple rows for each business object.) To 

change a datasource selection already made for an object, work in its existing 

row. 

3. If you’re adding a datasource, click in the Business Object field of a new row 

and select the Business Object for which you want to add a source. If you’re 

modifying an existing datasource, locate the row in which the Business Object 

field displays the name of the object whose source you want to change. 

4. Click in the Datasource Name field, which lists datasources configured in the 

Manage Application Data page. Click on the datasource you want to associate 

with the business object. Other fields are populated automatically. 

If you selected the User or Access Entitlement business object in step 3, associ-

ate it with a Grc datasource (which exists automatically). For any other business 

object, select a datasource for an instance of a business-management application 

in which a model is to be run. (These are configured in the Manage Application 

Datasource page.) 

5. Click on the Save and Close button. If you’ve added datasources, their names 

appear in the Datasource field (alongside the Name field near the top of the 

Create Transaction Model page.) 

You can also delete the association of a datasource with a business object. While the 

Manage Datasources window is open, select (click on) the row for the association 

you want to delete. Click on Actions > Delete or on the red × icon. 

Arranging Filters, Functions, and Patterns 

Each model element you create (filter, function, or pattern) appears as a dialog box 

in a Model Logic panel. To define the element, make selections in the fields dis-

played by its dialog box. As you add elements, position each vertically or horizon-

tally with respect to others: 

• A vertical arrangement indicates an AND relationship: Elements at one level are 

evaluated before those at the level below it, the topmost first and the bottommost 
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last. Presuming that processing at any vertical level returns records, processing 

continues on those records at the next level. For the model to return any results, 

every vertical level must evaluate to true (filters at every level must identify 

transactions). A pattern can form only an AND relationship with other objects. 

• Filters and functions, however, may be positioned horizontally to one another. 

Horizontal placement indicates an OR relationship — if any one filter or function 

within a horizontal set returns results, processing moves to the next vertical level. 

To add the first element to a model, click on a button (or a corresponding option in 

the Actions menu) that selects the type you want — New Filter, New Function, or 

New Pattern. To add subsequent elements, click again on any of those buttons (or 

menu options). As you do, keep these concepts in mind: 

• Each element you add appears by default immediately beneath the lowest ele-

ment in your model hierarchy. If, for example, a model contains four vertical levels 

and you click on the New Filter button, a filter appears at the fifth vertical level. 

Arrows connect one level to the next, indicating the flow in which elements are 

to be evaluated. 

• You can drag and drop existing elements to new positions within the model. 

Move the mouse cursor to the upper middle of the element you want to move. 

Left-click, hold the mouse button down, and do either of the following: 

– To create an OR (horizontal) relationship, drag the element on top of any 

other. (“On top of” means that you move one element so that it takes up the 

same space as, and so overlays, another. It does not mean that you drag an 

element to the upper border of another.) You can add any number of ele-

ments to the OR relationship by dragging each new element on top of any 

currently in the OR relationship. 

– To rearrange or create an AND (vertical) relationship, drag any filter to one 

of the arrowheads that demarcate the levels of your model hierarchy. How-

ever, as you drag a filter beneath a level that defines an OR relationship, you 

can drag only to the arrowhead that represents the entire OR relationship, not 

to any “internal” arrowheads. Also, you cannot drag a filter above the first 

filter in your model hierarchy. 

• Once two or more elements exist in your model, you can select them: hold 

down the Ctrl key and click in the upper middle of each element you want to 

select. When you select an element, it is enclosed in a box made of dashed lines. 

You can select one or multiple elements, but in the latter case, select elements 

that are adjacent to one another. (To deselect an element, hold the Ctrl key and 

click on the element again; the dashed lines disappear.) 

• You can incorporate elements into groups: select those you want to include and 

click on the Group Filters button (or on Actions > Group Filters). You can drag 

and drop groups in the same ways as individual elements. To dissolve a group, 

select it and click the Ungroup Filter button (or Actions > Ungroup Filter). 

• A transaction model should not contain more than one pattern. 

Create structures as complex as you like. For example, an OR statement may contain 

any number of elements. 

Or, a filter may have an AND or OR relationship with blocks of other filters. For example, 

suppose filters One, Two, and Three are in an AND relationship — stacked vertically. 
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You could drag Three into a horizontal pairing with Two; One would remain centered 

above them. The model would return results if One returned results and then either of 

Two or Three returned results. 

For another example, suppose filters One, Two, Three, and Four are stacked verti-

cally. You can select One and Two and enclose them in a group, select Three and 

Four and enclose them in a group, and then drag the Three and Four group into a 

horizontal pairing with the One and Two group. The model would return results if 

transactions were captured by filters One and Two, or by filters Three and Four. 

Creating a Standard Filter 

To create a standard transaction filter:  

1. Click on the New Filter button, or on Actions > New Filter. A dialog box 

appears in the Model Logic panel. 

2. Enter a name for the filter in the Filter field. 

3. An Object field lists all of the business (or custom, system-generated, or user 

defined ) objects you’ve added to the model in the Model Objects panel. Select 

(click on) the one from which you want to select an attribute for use in this 

filter. 

4. An Attribute field presents a list of attributes belonging to the object you selected 

in step 3. Select (click on) the one you want to use in this filter. 

5. A Condition field presents a list of operators that may be applied to the attribute 

you selected, usually to force a comparison between each attribute value and a 

third (yet-to-be specified) term in the filter. Select one. Among the following, 

you will see only conditions appropriate for the attribute you’ve selected. 

• Mathematical operators: The filter returns results if the value of the attribute 

equals, does not equal, is less than, is less than or equal to, is greater than, 

or is greater than or equal to a specified value. 

• Between: The filter returns results if the value of the attribute falls between 

two other specified values. 

• Contains and Does not contain: The filter returns results if the value of the 

attribute is a text string that includes, or excludes, a specified text string. 

• In and Not in: The filter returns results if the value of the attribute is a text 

string that matches, or does not match, a value in a semicolon-delimited set 

of text-string values. The match must be exact. 

• Starts with and Ends with: The filter returns results if the value of the 

attribute begins or concludes with a specified string of alphabetic or nu-

meric characters.  

• Is blank and Is not blank: The filter returns records for which the attribute 

column either contains no value, or contains any value. 

• Is not related to: The filter returns records of items that should, but do not, 

have links to other items. For example, invoices should have references 

(links) to purchase orders, and a filter using this condition would return 

records of those that don’t. 
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• Similar and Similar to: The filter selects records in which the values of one 

or two attributes are comparable. The Similar condition checks for similar-

ity in the values of the attribute you selected in step 4. The Similar to con-

dition checks for similarity in that attribute and a second one that you spec-

ify; a value of either attribute may be similar to other values of the same 

attribute or to values of the other attribute. 

The filter sets a standard of similarity, then collects records into groups, in 

each of which attribute values meet the standard of similarity in a distinct 

way. 

Text attribute values are similar if the number of matching characters in 

each equals (or exceeds) a specified percentage of the total characters. For 

example, two six-character text strings are 50 percent similar if they share 

three characters. Values with distinct sets of matching characters form dis-

tinct groups. For example, values containing abc might constitute one group, 

and values containing xyz might constitute another. 

(Characters within one string need not be consecutive to match characters in 

another string. During analysis, the filter removes special characters and 

certain “stop words” from each string, converts each string to lower case, 

and arranges the words in each alphabetically. By default, the filter checks 

whether entire strings are similar. If a Similar Word advanced option is 

selected, however, the filter checks for similarity in a single word within 

each string.) 

A numeric attribute value is similar to others if it falls within a range above 

and below the average of values already included in a group. You specify a 

percentage that defines the range: Its lower limit would be that percentage 

of the average of values in a group. Its upper limit is a “mirror image” of the 

lower — the same number of points above 100 percent as the specified per-

centage is below. For example, if you specify 85 percent, the filter multiplies 

the average of values in a group by 0.85 and 1.15 to define the range. And 

so the values 22 and 20 might belong to one group, and 9 and 8 to another. 

(Note: In this case, 7 would not be similar to 9 and 8, because the 85 per-

cent range around the average of 9 and 8 would be 7.225 to 9.775.) 

Date attribute values are similar if they fall within a specified number of 

days of one another. 

A given record may qualify for more than one group. By default, however, 

it belongs only to one group — that for which it happens to qualify first. 

(Text strings are evaluated for similarity in ascending alphabetic order; 

numeric strings in descending numeric order.) You can set a Generate 

Results for Similar Groups advanced option to have records belong to all 

groups for which they qualify. 

By default, the filter does not capture records that are not similar to other 

records. For example, if three records included the values 35, 9, and 8 for 

some numeric attribute, and the filter tested that attribute for 85 percent 

similarity, the filter would return the latter two records, but exclude the 

record including the value 35. (However, you can select an Include Unique 

Data Rows advanced option to have the filter return records it would 

otherwise exclude.) 
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• Different than: The filter returns records for which two specified attributes 

have dissimilar values. Again, similarity is measured in percentage or, for 

dates, number of days. This condition checks for dissimilarity in the values 

of the attribute you selected in step 4 and a second one; the values of each 

attribute are compared not only with themselves, but also with the values of 

the other. In effect, Different than would return the records that Similar to 

would not return. 

• Expresses: The filter returns records if the value of an attribute (supplied by 

either a standard business object or a custom object) is a text string that con-

tains any term listed in a custom dictionary. For the Expresses condition to be 

used, the dictionary must first be created as a custom object (see page 2-5). 

• Related to: Establishes a join relationship between an attribute of a user 

defined object (see page 3-6) and an attribute of a seeded business object, a 

custom object, or another user defined object. (When it is created, a user de-

fined object has no join relationship to any other object.) The join relation-

ship created by this condition is “dynamic” — valid only for the model (or 

control) in which it is created. This condition is available only when a user 

defined object (or custom object) is selected as the first object in a filter 

definition (step 3). A given user defined object can have only one dynamic 

join relationship per model. 

6. Define the third term of the filter, the format of which varies according to the 

condition you selected. 

• If you selected any of the mathematical operators, select either “Value” or 

“Object” in the Type field. If you select “Value,” a Value field appears. In 

it, enter a value to be compared with values of the attribute you selected in 

step 4. If you selected a date attribute, the less- and greater-than conditions 

enable you to select either a fixed value (an actual date) or a relative value 

(a number of days, weeks, or months from the system date). 

If you select “Object,” new Object and Attribute fields appear. In them, 

select a business object and an attribute within it, whose values are com-

pared with those of the object-attribute pair you selected in steps 3 and 4. If 

a filter uses the Equals condition, you can select the same business object 

and attribute as you did in steps 3 and 4; if so, the filter returns sets of values 

(see page 2-14). If a filter uses the Does not equal condition, you cannot 

select the same business object and attribute. 

• If you selected the Between condition, a Type field reads “Value,” and two 

Value fields appear. In them, enter two values that set the range between 

which attribute values must fall for the filter to return results. 

• If you selected the Contains or Does not contain condition, select either 

“Value” or “Object” in the Type field. If you select “Value,” a single Value 

field appears. In it, enter a text string that may appear at any position within 

a larger text string. If you select “Object,” new Object and Attribute fields 

appear. In them, select a business object and an attribute in it, whose values 

may be contained within those of the attribute in the first term of this filter. 

• If you selected the In or Not in condition, a Type field reads “Value,” and a 

Value field appears. In it, enter a text string, or a set of text strings delimited 
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by semicolons, any of which may match values for the attribute you selected 

in step 4.  

• If you selected the Starts With or Ends With condition, select either “Value” 

or “Object” in the Type field. If you select “Value,” a Value field appears. 

Enter alphabetic or numeric characters with which attribute values must begin 

or conclude. If you select “Object,” new Object and Attribute fields appear. In 

them, select a business object and an attribute within it; beginnings or endings 

of its values must match those of the attribute in the first term of this filter. 

• If you selected the Is blank or Is not blank condition, there is no third term 

(because the first two terms are sufficient to define the filter). 

• If you selected Is not related to, Object and Attribute fields appear. Select an 

attribute (and its object) to which the filter’s initial attribute should be related. 

For example, if the initial attribute is Invoice ID, this attribute might be Pur-

chase Order ID, to return records of invoices without linked purchase orders. 

• If you selected Similar, the filter checks for similarity in the values of the 

attribute you’ve already selected in step 4. If you selected Similar to or 

Different than, a pair of fields appears; in it, select an attribute (and its object) 

whose values are also checked for similarity or dissimilarity. In a Percent 

Similar field, enter a number from 50 to 99 that sets the standard for simi-

larity among text or numeric attribute values. Or, for date attributes, a Within 

Days field replaces the Percent Similar field; in it, enter a number of days 

that defines a range in which dates are considered similar. 

• If you selected Expresses, new Object and Attribute fields appear. In the 

Object field, select the custom object configured as the dictionary contain-

ing terms for which the Expresses condition searches in the attribute speci-

fied in step 4. In the Attribute field, select “Word.” 

• If you selected Related to, new Object and Attribute fields appear. Select an 

attribute (and its object) for which a join relationship is to be created to the 

user defined object and attribute that form the first term of the filter.  

7. Optionally, select advanced options. The following options are available to 

filters; click on the ± toggle icon next to the Advanced Options label to reveal 

them, although you will see only those appropriate for the filter you defined. 

• Exclude: Removes records defined by the filter from analysis. In effect, the 

filter returns all records that do not meet its specifications. 

• Include Unique Data Rows: This option is available if the filter uses the 

Similar or Similar to condition. Clear it (the default) to create groups of 

records, in each of which attribute values meet the specified similarity in a 

particular way, and to exclude records that are not similar to any others. 

Select the option to create the same groups, but also create one-member 

groups for records with attribute values that have no similar values. When 

this option is used, a Similar or Similar to filter does not exclude data. 

• Generate Results for Similar Groups: This option is available if the filter 

uses the Similar or Similar to condition. Although each transaction returned 

by the filter may qualify for any number of groups, it belongs by default only 

to the one group for which it qualifies first. Thus, each transaction would 

appear in model results only once (and even this depends on whether the 
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transaction is selected by subsequent filters in the model). Choose this option 

to have each transaction be included in all the groups for which it qualifies, 

and so appear multiple times in model results. 

• Similar Word: This option is available when the Similar or Similar to 

condition is applied to text strings. If the option is selected, two strings are 

similar if any single word within one is similar to any word within the other. 

If the option is not selected, then the two entire strings would have to meet 

or exceed the similarity threshold established by the filter. 

• Apply condition across the same data row: This option is available when a 

filter uses the Similar to condition and specifies two attributes that belong to 

a single business object. When the option is cleared, the filter compares 

values across all rows of the business object. A value of either attribute may 

be similar to other values of the same attribute or to values of the other 

attribute (which is standard behavior for the Similar to condition). When the 

option is selected, the filter considers each row individually; because cross-

row comparisons are not made, a value of one attribute can be similar only 

to a value of the other attribute.  

• Partial Match: If a model includes filters that generate “parent” and “child” 

sets of records, this option determines how parent values are matched to 

child values to determine what records are returned as model results. For 

more detail, see “Using Filters That Return Sets of Values” (page 2-14). 

• Include Empty Row: This option is available only to a filter that uses the 

Expresses condition. Its use requires that an empty row be included in the 

custom object configured as the dictionary containing terms for which the 

Expresses condition searches (see page 2-6). If this option is cleared, the 

filter returns only records (for the attribute specified in step 4) that include 

terms in the dictionary. If the option is selected, the filter returns all values 

for the attribute; those without dictionary terms have a relevance of 0.  

• Match Case: Consider upper and lower case while looking for matches in 

text values. If this option is not selected, text searches are case-insensitive. 

• Ignore leading and trailing spaces: Do not consider leading and trailing 

spaces when looking for matches in text values. 

• Ignore after floating point: In numeric values, do not consider digits after a 

decimal point. (For example, if this option were applied to a filter that specified 

“Payment Amount ends with 5,” the filter would return the value 25.67.) 

• Enable Synonyms: Apply a basic thesaurus lookup while searching for 

matches in text values. For example, if this option were selected for a filter 

that specifies “supplier name contains company,” the filter would return records 

in which the supplier name contains the word corporation or firm as well. 

• Include time with date: Consider both date and time for date-value matches. 

• Apply range of time: If “Include time with date” is selected, select a 

beginning time and an ending time and find matches only for records that 

fall within the defined time range. 

• Apply day of week: If “Include time with date” is selected, select one or more 

days of the week and find matches only for records worked on those days. 
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Using Filters That Return Sets of Values 

In transaction models (and controls), filters that use certain conditions may return 

sets of values: 

• Equals: A filter may state that an attribute of a business object is equal to itself. 

If so, the records returned by the filter form sets. The first set consists of all records 

in which the attribute equals a specific value (for example, Supplier ID = 1234). 

The second set comprises all records in which the attribute equals another value 

(for example, Supplier ID = 1235). And so on. 

• Similar and Similar to: Whenever the Similar condition is used, a filter compares 

an attribute of a business object to itself. When Similar to is used, the filter com-

pares the attribute both to itself and to another attribute. In either case, the filter 

returns sets of records. The first set includes records that satisfy the filter’s defi-

nition of similarity in one way, the second contains records that satisfy the 

definition in another way, and so on. 

Suppose, for example, the Similar condition is used to find a 50 percent likeness 

for an attribute all of whose values are six-character text strings. One set of return 

values might consist of records in which the string contains blt, a second set may 

comprise records in which the string contains pbj, and so on. 

The records returned by such a filter serve as a “system-generated object,” which 

means they may be used in subsequent filters as if they were a business object. For 

this purpose, the records are labeled as Condition[Object.Attribute], in which 

Condition is replaced by the name of the condition used in the filter, and Object and 

Attribute are replaced by the names of the business object and attribute cited in the 

filter. For example, if a filter equates the Invoice Number attribute of the Payables 

Invoice object with itself, the return values would be labeled “Equals[Payables 

Invoice.Invoice Number].” 

(Two such filters may be joined in an AND relationship to produce more narrowly 

defined sets of values. If so, the result sets are named Condition[Object1.Attribute1 

AND Object2.Attribute2]. If three, then Condition[Object1.Attribute1 AND 

Object2.Attribute2 AND Object3.Attribute3]. And so on.) 

In one common usage, a filter uses Similar, Similar to, or Equals to establish sets of 

records. A subsequent filter cites those sets as a system-generated object, so that it can 

apply a function to each set of records. (See “Creating a Function” on page 2-15.) 

In another common usage, an Equals filter creates a system-generated object. That 

object consists of sets, in each of which records share an attribute value. To distin-

guish among records in each set, a second filter uses the Does not equal condition. It 

states that an attribute of the system-generated object does not equal itself. This 

attribute is necessarily other than the one used by the Equals filter. 

(Note: In a filter that uses the Does not equal condition, you cannot specify that an 

attribute of a business object does not equal itself. You can, however, specify that 

an attribute of a system-generated object does not equal itself, if that object is cre-

ated by an Equals filter. Similarly, if a filter uses the Different than condition, you 

cannot specify that an attribute of a business object differs from itself. However, 

you can specify that an attribute of a system-generated object differs from itself, if 

that object is created by a Similar or Similar to filter.) 
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You may, for example, want to identify distinct suppliers who have been assigned 

duplicate invoice numbers. To begin, create a filter in which the Invoice Number 

attribute of the Payables Invoice business object equals itself. This creates a system-

generated object called Equals[Payables Invoice.Invoice Number] — sets of records, 

in each of which all records have the same invoice number. Next, create a second 

filter in which the Supplier ID attribute of the Equals[Payables Invoice.Invoice 

Number] object does not equal itself. This identifies distinct suppliers in each set. 

(You can use a system-generated object in filters that use conditions other than Does 

not equal as well — all except Similar, Similar to, and Different than.) 

Further, you can create a model in which one or more filters generate “parent” sets 

of records, and a second one or more filters generate distinct “child” sets of records 

that have an attribute in common with the parent sets. The model matches values in 

the parent “set of sets” with those in the child “set of sets” to determine which sets 

are included among model results and which are discarded. 

For example, you might create two filters that use attributes of the Payables Invoice 

business object. In the first, the Invoice Number attribute equals itself; in the second, 

the Invoice Amount attribute equals itself. The result is a system-generated object 

called Equals[Payables Invoice.Invoice Number AND Payables Invoice.Invoice 

Amount] — sets of invoices, in each of which all invoices have the same number 

and same amount. A third filter might specify that the Supplier ID of that system-

generated object does not equal itself. The result is parent sets of invoices, in each 

of which invoice number and amount are the same, but at least one supplier ID dif-

fers from the others. (If no supplier ID is unique within a set, that set is discarded.) 

A final filter might equate the Taxpayer ID attribute of the Supplier business object 

with itself. Its result is a new, child set of sets. In each set the taxpayer ID is the 

same for all records, but it may correlate to any number of supplier IDs. The model 

would compare parent and child sets, and keep only those parent sets in which it 

finds matching values. 

A Partial Match advanced option determines how this matching is done. You select 

or clear the Partial Match check box in the filter that defines the child sets. If this 

check box is cleared (the default), all values for the common attribute in a parent set 

must match values in at least one child set. If this check box is selected, only one 

value for the common attribute in a parent set need match a value in a child set. 

In the example, the common attribute is Supplier ID. If the Partial Match check box 

is cleared, then every supplier ID in a given parent set must appear in one of the 

child sets for the parent set to be kept among the model results. If not, the entire 

parent set is discarded. 

However if the Partial Match check box is selected, and any one supplier ID in a 

given parent set appears in one of the child sets, the entire parent set is kept among 

model results. If no supplier ID in a parent set matches an ID in a child set, the 

entire parent set is discarded. 

Creating a Function 

A function applies a calculation to groups of attribute values, then determines 

whether each calculated value poses a risk. To do so, the function must establish 

groups of records to which it applies the calculation. 
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The function can perform this grouping on its own, in which case each group con-

tains records for which the values of an attribute exactly match. Or, the function can 

be used in conjunction with a standard filter that uses the Similar, Similar to, or 

Equals condition to create sets of records (a system-generated object).  

If you intend to use such a filter to group records, create it first. Then create the 

function, placing it in an AND relationship with (below) the filter. 

To create a function: 

1. Click on the New Function button, or on Actions > New Function. A dialog box 

appears in the Model Logic panel. 

2. Enter a name for the function in the Function field. 

3. In a line labeled Filter, use Object and Attribute fields to gather records into groups. 

Do either of the following: 

• If the function is to perform the grouping on its own, select a business 

object in the Object field and one of its attributes in the Attribute field. The 

function will then create sets of records; in each set, values for that attribute 

exactly match. 

• If you have created a standard filter that produces a system-generated 

object, select the name of that object in the Object field, and one of its 

attributes in the Attribute field. This creates subgroups: records in each 

group defined by the system-generated object are further sorted on the 

values of the attribute you select. (In this case, the setting of a Generate 

Subgroups advanced option may determine how the function filter uses 

these groups and subgroups to report results.) 

4. In a line labeled When, use a Function field to select the calculation that is to be 

performed on grouped attribute values. These functions include the following: 

• Average: Calculates the average of the attribute values. 

• Count: Determines how many attribute values exist. 

• Sum: Adds the attribute values together. 

• Rank: Arranges attribute values in ascending order. 

• Exclusive: Determines whether all of a set of semicolon-delimited text 

strings are included in records for a group. (One use would be to determine 

whether expenses listed in a set of expense reports contains conflicting 

values — for example, gasoline purchases and taxi expenses.) 

• Inclusive: Determines whether one or more, but not all, of a set of semicolon-

delimited text strings are included in records for a group. (One use would be 

to determine whether expenses listed in a set of expense reports do not con-

tain complementary values — for example, rental car but no gasoline purchases.) 

5. Next to the Function field, use Object and Attribute fields to select the attribute 

(and the object to which it belongs) upon which the function will perform calcu-

lations. (The Attribute field displays only attributes appropriate for the function 

you selected in step 4.)  

6. In the remaining fields of the When line, complete the logical formula that defines 

what makes a transaction risky. To do so, specify a condition and (if needed) a 

third term, as described in steps 5 and 6 of “Creating a Filter” (page 2-9). 
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Note for the Rank function: You will select a condition and a value, which 

determine which records are ranked. For example, “Equals 4” would cause one 

record to be returned for each group, containing the fourth-ranking value of the 

attribute you selected in step 5. Or “Less Than 4” would cause three records to 

be returned for each group, containing the first- through third-ranking values. 

7. Optionally, select advanced options. The following options are available to 

functions; click on the Advanced Options ± toggle icon label to reveal them, 

although you will see only those appropriate for the function you have defined. 

• Exclude: Removes records defined by the filter from analysis. In effect, the 

filter returns all records that do not meet its specifications. 

• Generate Subgroups: This option is available when a system-generated 

object is selected in the Filter line, and is typically used when the Count 

function is selected in the When line. If the option is cleared, the function 

counts the number of subgroups that belong to each group defined by the 

system-generated object. (Another way to express this is the number of 

values that exist for the attribute selected in the Filter line.) If the option is 

selected, the function counts the number of records in each subgroup (if the 

attribute selected in the Filter line is also selected in the Result Display panel) 

or the number or records in each parent group (if the attribute selected in the 

Filter line is not selected in the Result Display panel). 

• Partial Match: If a model includes filters that generate “parent” and “child” 

sets of records, this option determines how parent values are matched to 

child values to determine what records are returned as model results. For 

more detail, see “Using Filters That Return Sets of Values” (page 2-14). 

• Over interval: This option is available to a function in which the attribute 

selected in step 3 is a date. If the option is cleared, the function groups records 

so that each group contains records that share a date. If the option is selected, 

the function groups records so that each group contains records whose dates 

fall within a time period. To specify the period, select Overlap or Successive 

in an Interval Type field. Overlap means that the time periods overlap with 

one another (for example, if the time period is every two days, periods may 

include Monday and Tuesday, Tuesday and Wednesday, and Wednesday and 

Thursday). Successive means that the time periods are distinct (in the every-

two-day example, Monday and Tuesday, then Wednesday and Thursday). 

Next, define the period: In an Interval field, enter a number, and in a Units 

field, select days, weeks, or months. Finally, select start and end dates. 

• Display in Descending Order: This option, available to filters that use the 

Rank function, reverses the rank ordering from ascending (the default) to 

descending. 

An example: A function may calculate the average transfer amount for bank account 

transfers, then find average transfer amounts that are greater than a threshold amount. 

It must group records by bank account, so that it can take the average transfer amount 

for each account. To do so, your function might group records by Bank Account ID.  

Select the Bank Account object and Bank Account ID attribute in the Filter line of 

your function. In the When line of the function, select the Average function, the Bank 

Account Transfer object, the Transfer Amount attribute, the greater than condition, 

and whatever value you choose as a threshold 
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Creating a Pattern 

You can add one pattern to a given model (and the addition of that pattern classifies 

the model as the pattern type, even if it contains defined filters). There are initially 

two patterns. Each calculates a baseline value and identifies transactions that vary 

excessively from the baseline; each takes parameters, which enable you to define 

the variance that is considered excessive. 

• Benford: Benford’s Law states that even in widely varied sets of numeric data, 

the frequency distribution of leading digits is predictable. For example, approx-

imately 30 percent of values begin with the digit 1 (if values are expressed in base 

10). This pattern compares the distribution of leading digits in sets of numbers 

with the distribution predicted by Benford’s Law, and identifies discrepancies. 

To define the data sets, specify one or more attributes that return number values. 

Discrepancies are values that are some percentage above or below the Benford 

values; set Greater Than and Less Than parameters to define these percentages. 

• Mean: This pattern calculates a mean for a set of attribute values, and identifies 

individual values that are too far above or below the mean. Parameters include the 

amounts above and below the mean at which outliers are identified. 

To create a pattern: 

1. In the Model Logic panel, click on Actions > New Pattern, or on the New 

Pattern button. A dialog box appears.  

Note that you must first have selected at least one business object for the model 

with at least one attribute that provides data upon which patterns can operate (in 

the case of Benford and Mean patterns, numeric values). Otherwise, an error mes-

sage informs you that no pattern is associated with the selected business objects. 

2. Enter a name for the pattern in the Pattern field. 

3. In the Pattern list box, select the pattern you want to use. (If you have not selected 

a business object appropriate for your patterns, however, this list box is empty.) 

4. Click on the green + icon; a row appears beneath the Object and Attribute 

headings. In the Object field of this row, select a business object; in the 

Attribute field, select an attribute belonging to the object. These fields display 

only objects and attributes upon which your pattern can operate. You may 

create additional rows to select additional attributes for the pattern to evaluate. 

You may also select a row and click on the red × icon to delete the row. 

5. Under the headings Parameter, Value, and Unit, one row appears for each 

parameter appropriate for the pattern you’ve selected. For each parameter row, 

enter a value in the Value field and select a unit of measurement to apply to that 

value — for example, 20 percent. 

Defining Model Results 

Once the model logic is developed, select attributes for which the model, when it is 

run, will return values for each risky transaction it finds. 

A model may incorporate “derived attributes” — those that exist only as calcula-

tions performed by the model, such as the third term in the logical formula created 

by a filter that sets an attribute equal or similar to itself, or the sum, average, or count 

in a function filter that performs one of these calculations. Derived attributes are 

included automatically in model results and cannot be removed.  
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You must actively select any other attribute to include it among the model results — 

even those cited in filters that define model logic.  

Choose attributes that reflect the level of detail you want to see in your results. For 

example, a model may group invoices by supplier (include a filter that sets the 

Supplier ID attribute of the Payables Invoice business object equal to itself). It may 

also include a function filter that calculates a sum of invoice amounts for each sup-

plier. The sum value, a derived attribute, is included automatically in the result set.  

You may actively select the Invoice Amount attribute of the Payables Invoice busi-

ness object for the result set. (It is not included automatically, even though the model 

logic uses it to calculate sums.) If you do, results would include a row for each invoice; 

this would be required to display the amount for each invoice. (Each row would also 

display the sum of its supplier’s invoices.) If you do not, the results include only one 

row for each supplier, displaying the sum of that supplier’s invoices. 

To define results: 

1. Scroll down to the Result Display panel in the Create Transaction Model page. 

(Or, collapse other panels by clicking on their ± toggle icons.) 

2. An Available box lists the business objects included in the model. For each, 

click on the ± toggle to reveal a list of the attributes that belong to the object. 

3. Select an attribute for which you want to see results (click on it), then click on 

the > button. The attribute moves to a Selected box. Repeat this process for all 

other attributes for which you want to see results. Alternatively, click on the >> 

button to move all attributes to the Selected box. 

If you reconsider your choices, select attributes individually in the Selected box 

and click on the < button to return them to the Available box. Or, click on the 

<< button to return all attributes to the Available box. 

Saving the Model 

To save the model, click the Save button or the Save and Close button. Both are 

located near the upper right corner of the Create Transaction Model page. The Save 

option saves the model, but leaves its values on display for further editing, or for the 

generation of results. The Save and Close option saves the model but empties the 

Create Transaction Model page so that it is ready for the creation of a new model. 

Alternatively, you can click the Cancel button and respond to a confirmation prompt 

to restore the blank Create Transaction Model page without saving the model. 

Viewing or Exporting Model Results 

From either the Manage Transaction Models page or the page in which you create 

or edit a model, you can view results from the most recent run of a model (if it has 

been run before), or run the model and view a new set of results. 

Before running a model, consider synchronizing data from the datasource against 

which the model will run; this would ensure that transaction data is up to date. Use 

either of the processes described in “Model-Data Synchronization” (page 2-2) or 

“Synchronizing Data” (page 1-5). 
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No matter which page you use to display model results:  

• For a defined transaction model, the window displays a grid that devotes a row 

to each risky transaction. Each row includes values for the results attributes 

selected when the model was created or edited. 

• A pattern transaction model generates both graphic and tabular results. The 

graph presents a baseline identified by the pattern, and outliers to it. The table 

displays values that define data points in the graph. If the pattern analysis uses 

multiple attributes, the results page generates multiple result tabs, each of which 

presents a graph and a table related to one of the attributes used in the pattern 

analysis. 

If you hold the mouse cursor over a data point in a graph, a box displays the 

values defining that point. If you click on the data point, the grid refreshes to 

display only values for the data point you’ve selected. 

To open the results window from the page in which you create or edit a model, 

select one of three buttons, which appear in the title bar of the Model Logic panel: 

• Run: The model runs, and the page remains open. If the model had been run 

before, the new run overwrites the existing results (with no prompt to save or 

view them). 

• Run in Background: The model runs, but you may navigate to another GRC 

page and work there. Again, if the model had been run before, the new run 

overwrites the existing results. 

• View Existing Results: For a model that had been run before, the results 

window displays the results generated in the most recent run. 

To open the results window from the Manage Model page, do either of the following: 

• Locate the column labeled “View Results.” In it, the entry for each model 

contains a prompt (which also reads “View Results”) if the model has been run. 

(If not, the View Results cell is blank.) Click on the prompt (if one appears) for 

the model whose results you want to view. 

• In the Manage Models grid, click on the row for the model whose results you 

want to view. Then, in the menu bar, select Actions > View Results. 

If the model has not been evaluated previously, GRC simply runs it. If the 

model has been evaluated previously, a dialog box prompts you to decide 

whether to overwrite existing results. Select No to display the existing results. 

Select Yes to generate and display a new set of results. 

To view the status of a model run, open a Manage CCM Jobs page: select Contin-

uous Control Management under Continuous Monitoring in the GRC Navigator, then 

select Manage CCM Jobs under Control Administration in the Tasks list. (See “Jobs 

and Scheduling” in the Enterprise Governance, Risk and Compliance User Guide.) 

You can export model results to an Excel spreadsheet. To do so: 

1. In the results window, click on Actions > Export to Excel. 

2. A pop-up window offers you options to open or save the export file. Typically, 

click on its Save button and, in a Save As dialog, navigate to a folder in which 

you want to save the file. 
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3 

Creating and Managing Continuous Controls 

Typically, a continuous control defines risk and generates incidents — records of 

transactions that exceed the defined risk. A control may instead define a set of data 

that is incorporated into a user defined object, which may then be used in other trans-

action models and controls as if it were a business object. 

In either case, to create the control a user selects a model; the control adopts its risk 

definition (filtering logic). The user adds information needed for the control to be 

applied: whether it is to generate incidents or a dataset; a datasource to which the 

control is applied; perspective values, and users (associated with those values) who 

can resolve incidents; a priority; and more. 

A Manage Controls home page presents a list of controls, with summary data about 

each. To open the page, select Continuous Control Management in the Navigator, then 

Manage Controls among the Continuous Control Management tasks. You can see 

only those controls to which your data roles give you access.  

You can edit existing controls or create new controls from existing models. You can 

also evaluate controls, import or export them (page 1-7), and run a report about them. 

For each control that you select to edit, GRC opens a distinct, tabbed page. To return 

to the Manage Controls home page, close the control-view page by clicking its 

Done button, or click on the Manage Controls tab.  

Creating Transaction Controls 

Because every control is based on a model, ensure that at least one transaction 

model exists before you attempt to create a transaction control. You may convert 

any number of transaction models into controls at once. If you create more than one, 

their processing logic, names, and descriptions remain distinct. Moreover, each con-

trol inherits an Allocated Analysis Time Per Filter setting from the model on which 

it is based. (For more on this setting, see “Choosing Whether to Limit Analysis Time” 

on page 2-4.) Other values are the same for all the controls you create at once. 

To create controls: 

1. In the Manage Controls home page, click on Actions > Create Transaction 

Control. 

2. A Create Control: Choose Model window opens. In an Available Models grid, 

select models you want to convert into controls: To select one, click on it. To 
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select a continuous set, click on the first, hold down the Shift key, and click on 

the last. To select a discontinuous set, hold down the Ctrl key as you click on 

models. A Model Logic panel displays the filters that define each model you 

select; the last model you select is the one whose filters remain on view. 

3. Click on the Next button. A Deploy Control: Define Control Details window 

replaces the Choose Model window. In it, set the following values, as described 

below: name and description; priority, status, and result type; datasource; per-

spective values and users who can investigate control incidents; and comments.  

You may click on a Back button, to return to the Choose Model window and 

revise your model selection. If so, when you return to the Define Control Details 

window, any values you have selected remain in force. 

4. When you are satisfied with all the selections you have made, click on the 

Submit button in the Define Control Details window. 

Naming and Describing Controls 

In the Define Control Details window, a Details grid displays a row for each model 

you selected. Each row contains the name and description of its model. You can 

accept these as the names and descriptions of the controls you are creating, or click 

in each Name and Description field to create new values. 

Setting Priority, Status, and Result Type 

In the Priority field, enter a value that expresses the importance of the controls you 

are creating in relation to others. The value must be a number. (Your company should 

establish a set of priority values and enforce consistent usage.) 

In the Status list box, select Active (the default) to use the controls you create, or 

Inactive to hold them in reserve. 

In the Result Type list box, select “Incident” if you intend for the controls to gener-

ate incidents, or “Dataset” if you intend for the controls to supply data to user defined 

objects (see page 3-6). 

Selecting Datasources 

The models upon which you are basing the controls you create are already associ-

ated with datasources. You may retain those datasources, but if you choose to do so, 

you must actively select them as you create the controls. Or, you may select new 

datasources for the controls you are creating. 

1. In the Define Control Details window, click on the Map Datasource button. An 

Import Datasource Mapping grid opens, displaying one row for each datasource 

specified in the models upon which you are basing your controls. 

2. Double-click in the Mapped Datasources list box for one of the rows. A Select 

Datasource window opens; in it, select a datasource appropriate for the environ-

ment in which controls are to be applied. Click the OK button; the Import Data-

source Mapping grid reappears, with your selection occupying the Mapped 

Datasource field in the row in which you had been working. Repeat this step for 

all other rows. 
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In each row, a Datasources Used field displays the datasource associated with a 

source model. You may select this or another datasource in the Mapped Data-

sources field to apply to controls you are creating. 

3. Click on the OK button. The Map Datasources window closes, and your selec-

tions appear in the Datasource field of the Define Control Details window. 

Selecting Perspective Values and Result Investigators 

Two sets of perspective values apply to controls and the incidents they generate: 

• “Perspectives” values apply to the control itself. Users have access to the control 

if their job roles include data roles associated with these perspective values (and 

if their duty roles grant privileges to work with controls). For each control, the 

Control Perspectives values are those assigned to the model upon which the con-

trol is based. You cannot modify these values as you create controls. 

For a control to inherit perspective values from a model, the perspective hierar-

chy cited by the model must also be associated with the control object (in the 

Manage Module Perspectives page). If not, the control has no Control Perspec-

tives values, and it is “orphaned” — it is inaccessible to any user whose data 

roles are associated with any perspective value. 

• “Result: Management Perspective Assignment” values apply to incidents 

generated by controls; select them as you create the controls. (See “Selecting 

Perspectives” on page 1-3.) Users are eligible to review these incidents if their 

job roles contain both a duty role with the privilege for incident review and a 

data role associated with perspective values matching those selected here. 

As you select perspective values in the “Result: Management Perspective Assign-

ment” panel, GRC users eligible to review incidents become available in the Result 

Investigator field. In that field: 

• Select All Eligible Users to permit incident review by any of those users. 

• Select Search to appoint a single user for incident review. A Search and Select 

Investigator dialog opens. In it, enter text strings to match any combination of 

username, given name, and surname. (Once again, you can use the percent sign 

as a wild-card character.) Then select the user you want.  

Writing Comments 

To add a comment to the controls: 

1. Click on the Add Comments button. An Add Comments dialog opens. 

2. In the Comments dialog, type the comment you want to add to the controls. 

3. Click on the Save button. The comment appears in the Comments panel of the 

Define Control Details window, together with the date, time, and your name. 
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Mass-Editing Controls 

You can modify certain settings — priority, status, comments, perspective values, 

and result investigator — for any number of existing controls at once: 

1. Select the controls you want to modify from the list of controls on the Manage 

Controls home page: To select a continuous set of controls, click on the first, 

hold down the Shift key, and click on the last. To select a discontinuous set, hold 

down the Ctrl key as you click on controls. Or, make no selection to edit all in a 

complete or filtered list of controls. 

2. Select Actions > Edit. An Edit Controls dialog opens. 

3. Modify any or all of the following: 

• In the Details panel, enter new values for priority (a number value), status 

(Active or Inactive), or comment. (The controls retain their original values 

for any of these fields you leave unedited.) 

• In each of the perspectives panels, select perspective values to be added to, or 

removed from, those already chosen for each control you are editing. Select 

the Add or Remove radio button, then move values to be added or removed 

from the Available Perspective Items list to the Selected Perspective Items 

list. As before, “Control Perspectives” apply to the controls you are editing, 

and “Result Management Perspectives” apply to incidents they generate. 

• Choose whether to select a result investigator (see page 3-3). By default, the 

field is blank; if you make no selection, each control retains the result inves-

tigator originally assigned to it. Or, a control defaults to All Eligible Users 

if its original investigator is invalidated by selections you’ve made for Result 

Management Perspectives. If you make a selection, it applies to all the con-

trols you are editing. Users available for selection are those whose data roles 

specify perspective values that are common to the controls you are editing. 

4. To complete the edits, click on the OK button. 

Viewing and Editing Individual Controls 

For each control, you can open a page in which you can view its full details. Or, you 

can open an edit version of that page, in which you can modify some configuration 

details, add comments, or revise perspective-value and result-investigator assignments. 

(Any number of pages, each devoted to a distinct control, may be open at once, but 

you must open them one at a time, to avoid triggering the mass-edit feature.) 

To open a control in view mode, click on its name in the Manage Controls home page. 

To open a control in edit mode, do either of the following: 

• Open a control in view mode, then click the Edit button in the view page. 

• In the Manage Controls home page, click in the row for the control you want to 

edit, and select Actions > Edit.  

In each of these pages: 

• A Details panel displays the name, description, status, and priority of the con-

trol. You can modify those values in the edit-mode page; enter values in write-
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enabled fields. This panel also displays information that cannot be edited, 

including the control type and result type; the datasources to which the control 

applies; dates on which it was created, last run, and last updated; a revision 

number; and whether the Allocated Analysis Time Per Filter feature (see page 

2-4) is enabled or disabled. 

• A Comments panel displays existing comments. When the page is in edit mode, 

you can add a comment as you would if you were creating a control. 

• A Control Perspectives panel displays perspective values currently assigned to 

the control. A Result Management Perspective Assignment panel displays per-

spective values assigned to control incidents, as well as the current result inves-

tigator. In the edit-mode page, you can modify perspective values (see page 1-3) 

and select a new result investigator (see page 3-3). 

• A Control Logic panel displays the filters, functions, or pattern that define the 

processing logic of the control, arranged in the AND/OR order in which they are 

analyzed. These elements cannot be edited. 

In the edit-mode page, click the Save button to save your modifications. In either 

the edit- or view-mode page, click the Done button to close the page. 

Running Controls 

You can cause GRC to analyze any selection of controls, returning incidents or 

compiling datasets for user defined objects (according to the Result Type selected 

for each control). To begin, choose the controls you want to analyze from the list on 

the Manage Controls home page: To select one, click on its row. To select a contin-

uous set of controls, click on the first, hold down the Shift key, and click on the last. 

To select a discontinuous set, hold down the Ctrl key as you click on controls. 

Then, do either of the following: 

• Evaluate the selected controls once, immediately. Select Actions > Run, or click 

on the Run button. GRC displays status of the run at the base of the Manage 

Controls home page. 

• Create a schedule on which the selected controls run regularly. Select Actions > 

Schedule, or click on the Schedule button. A Schedule Parameter dialog opens; 

in it, enter values that set a name for the schedule, the date and time at which it 

starts, the regularity with which the controls are evaluated, and the date and 

time (if any) on which the schedule expires. Then click on the Schedule button. 

Consider synchronizing data before evaluating controls, to ensure that transaction 

data is up to date. If you evaluate controls manually, you can synchronize data 

manually first. If you schedule control analysis, you can also create a coordinated 

schedule for data synchronization. In either case, you can synchronize data from the 

Manage Application Datasources page, which is opened from the Setup and Admin-

istration tasks. (See “Synchronizing Data” on page 1-5.) 

To view the status of a control run, open a Manage CCM Jobs page: select Con-

tinuous Control Management under Continuous Monitoring in the GRC Navigator, 

then select Manage CCM Jobs under Control Administration in the Tasks list. For 

more on this feature, see “Jobs and Scheduling” in the Enterprise Governance, Risk 

and Compliance User Guide. 
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Contextual Reporting for Controls 

From the Manage Controls home page, you can run a Control Detail Extract Report. 

For each control, it provides the name, description and comments, type (Access or 

Transaction), priority, status (Active or Inactive), and number of pending results. It 

identifies users who created and most recently updated the control, and dates on which 

they did so. Finally, it displays the control’s processing logic. 

To run the report: 

1. Filter the list of controls to include only those about which you want the report 

to display information — for example, a list of controls at a particular priority. 

If you do not filter the list, the report includes information about all controls to 

which your roles give you access. (For information on filtering, see “Searching 

Among Records” in the GRC User Guide.) 

2. In the Report list box, select the Control Detail Extract Report. 

3. In the list box immediately to the right of the Report list box, click on the 

format in which you want to produce the report. The value csv produces a file 

designed for export to another application, such as a spreadsheet, for further 

manipulation. The value pdf produces a formatted report that can be viewed in 

Adobe Acrobat. 

4. Click on the Print button. An Information pop-up window opens, identifying a 

job number. Note the number, then close the window (click on its OK button). 

5. Using the Navigator, go to Tools > Setup and Administration > Manage Jobs. In 

the Manage Jobs page, locate the row displaying the job ID you noted in step 4. 

When its Message cell displays a Job Completed link, click on the link. 

6. A Job Detail window opens. In it, click on the Item Results link. 

7. A file-download window offers you options to open or save the report. The 

precise behavior of this window depends on the web browser you use. In gen-

eral, if you choose to save, select the Save option. In a distinct save-as dialog, 

navigate to the folder in which you want to save the file.  

8. Close the Job Detail window (click on its OK button). 

Managing User Defined Objects 

A user defined object is a set of data returned by a CCM continuous control that is 

used as if it were a business object. Each column in the results returned by one of 

these specially configured controls serves as an attribute of the object generated 

from the control. 

In the current release, only a transaction model or control can cite a user defined 

object. However, either an access or a transaction control can serve as the basis of a 

user defined object. 

A control can generate incidents, or it can provide data to a user defined object, but 

it cannot do both. The user who creates a control determines which purpose it serves 

by selecting an appropriate value for a Result Type field — “Incident” for a control 

that generates incidents, or “Dataset” for a control that supplies data to a user 

defined object. 
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To create a user defined object: 

1. Create a model (page 2-3) from which you will develop a control, from which 

you will in turn generate a user defined object. 

2. Turn that model into a control (page 3-1), being sure to select “Dataset” as its 

result type. 

3. Open the Manage User Defined Objects page (Navigator > Continuous Control 

Management > Manage User Defined Objects). 

4. Select Actions > Create from Control. 

5. A Create from Control window opens. Enter appropriate values in its fields: 

• Based On Control: Select the control you created in step 2. (This field lists 

all controls for which the result type is “Dataset.”) 

• Business Object Name: Create a name for the user defined object (which 

need not be the same as the control from which the object is generated). 

• Description: Optionally enter a brief description of the object. 

• Domain: Select a value that characterizes the object. 

• Category: Select a value: Transaction is appropriate for an object in which 

data is updated frequently. Operational and Configuration are appropriate 

for master-data and setup records that change infrequently. 

• Status: Select Active or Inactive. 

6. Select the OK button. 

You must also run the control (see page 3-5). You may do so either before or after 

you enter values in the Create from Control window. However, you must do so 

before using the user defined object in a transaction model or control; otherwise no 

results will be generated. Each time the control is run, the data available to the user 

defined object is refreshed. 

The Manage User Defined Objects page displays records of all user defined objects 

in a “Search Results” grid. In it, you may select an object, then either edit or delete 

it. Select Actions > Edit to open a popup window in which you can modify the 

description, domain, category, and status values. Select Action > Delete, and then 

click OK in a confirmation message, to delete an object. However, you can delete an 

object only if it is not used in any control. (A Used in Control column indicates 

whether this is the case.) 

When it is created, a user defined object has no join relationship to any other object. 

As you create filters in transaction models, you can use a “Related to” condition to 

create a join relationship between a user defined object and another object. 
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Resolving Incidents 

The evaluation of transaction controls generates “incidents,” each the record of a 

transaction that exceeds the risk defined by a control. Each consists of values for 

attributes that were selected for a model from which the control was developed.  

A Manage Results home page presents incidents belonging to the person currently 

logged on to GRC — for your purposes, you. Incidents may belong to you because 

controls that generate them identify you as a result investigator, or because other 

investigators assigned them to you. To open the page, select Result Management in the 

Navigator, then Manage Incident Results among the Result Management tasks. 

From the Manage Results home page, you may navigate to other pages, which show 

detailed records of individual incidents. To return from those pages to the Manage 

Results home page, click on the Manage Results tab. 

The actual resolution of incidents occurs outside of GRC. For example, you may 

determine that a purchase order should be canceled if a transaction control shows 

that it is suspect; that action would be completed in the business-management appli-

cation to which it applies. The GRC Manage Results pages enable you to review 

incident details, and to set the status of incidents to reflect whether anything should 

be, or has been, done about them. 

Initially, incidents appear at an Assigned status, which means that you (potentially 

along with others) have been designated to address them. You can update an Assigned 

incident to any of the following statuses: 

• Accepted, which means you have determined that nothing need be done to 

resolve the incident. 

• Remediation, which means you have decided that some action must be taken in 

the business-management application to resolve the incident. 

• Resolved, which means you have confirmed that the remedial action has been 

carried out in the business-management application. 

GRC may set other statuses:  

• Control Inactive means that an incident is no longer of concern because the con-

trol that generated it has been inactivated.  

• Authorized and Closed apply exclusively to incidents generated by AACG con-

trols (See the Application Access Controls Governor User Guide.) 
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An incident has not only status, but also one of three states: In Investigation, Approved, 

or Closed. A user cannot directly set the state of an incident. He can change its status, 

then either save or submit it, and GRC assigns a state as a result of these actions. A 

submission can cause a state change; a save cannot. 

In general, if the status of an incident is Assigned or Remediation, its state is In 

Investigation; if its status is Accepted or Resolved, its state is Approved. However, 

because of the distinction between saving and submitting a status change, this is not 

always true. For example, an incident may be at the Remediation status and In Inves-

tigation state; a user may update status from Remediation to Resolved; but if he 

saves, rather than submits, the change, the incident remains at the In Investigation 

state. Or, a Resolved (and Approved) incident may be reopened, its status changed 

to Remediation; if it is submitted, its state changes to In Investigation, but if it is 

saved, its state remains Approved. 

If the status of an incident is Authorized, its state is Approved; if its status is Closed 

or Control Inactive, its state is Closed. 

State matters in part because the Manage Results page presents pending incidents by 

default, other pages show counts of pending results, and pending incident results are 

defined as those at the In Investigation state. (State matters also because each user’s 

access is determined by his data roles, which specify states at which he may access 

data.) To cause the Manage Results page to display incidents at other states (presum-

ing your data roles give you access to data at those states), use standard search fea-

tures. 

Viewing Controls or Incidents in Summary 

To review, edit, or assign status to incidents, open the Manage Results home page: 

select Manage Incident Results from the Result Management tasks available from the 

Navigator. 

From the Manage Results home page, you may navigate to other pages, which show 

detailed records of individual incidents (see page 4-4). To return from those pages 

to the Manage Results home page, click on the Manage Results tab. 

You can set the Manage Results home page to display either a list of controls that 

have generated incidents, or a list of incidents generated by those controls. In the  

control list, each control links to a list of the incidents only it has generated. From 

any list of incidents, you can open pages that provide details of individual incidents. 

• For a list of controls, select Control Summary in the View By list box. 

• For a general list of incidents, select Incident Results in the View By list box. 

For a list of incidents generated by a specific control, click on its Pending Result 

Count in the Control Summary list. 

You can hide or restore the columns that appear in the grids displaying controls or 

incidents; right-click in the header row of the grid to open a checklist of columns. 

Those available for incidents include the following: 

• Incident Information: For a transaction incident, this is the value of the first 

attribute among those selected to characterize the suspect transaction. (These 
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values were selected during configuration of the model that served as the basis 

of the control that generated the incident.) 

• Group and Grouping Value fields: For transaction incidents, results vary. 

– If a transaction control uses a filter in which the Equals condition sets an 

attribute of a business object equal to itself, the Group field reports the 

business object and attribute cited in the control, and the Grouping Value 

field reports the common value of this attribute.  

– If a transaction control uses a filter to find transactions with similar values 

for a specified attribute, the Group field displays the word Similar and the 

specified attribute, and the Grouping Value field displays the value of that 

attribute for a given incident.  

– If a transaction control uses a function to calculate a value for a specified 

attribute across a group of transactions, the Group field identifies the calcu-

lation (count, sum, or average) and the specified attribute, and the Grouping 

Value field displays the calculated value for a given incident.  

– If a transaction control uses a pattern to create a baseline value, the Group 

field displays the pattern type and the attribute upon which the pattern is 

based, and the Grouping Value field displays the baseline value. 

Mass-Editing Incidents 

You can set status for any number of incidents, or write comments for them, all at 

once. To do so, first choose the incidents with which you want to work: 

1. Generate a list of incidents in the Manage Results home page.  

2. In that list, select any number of incidents. To select a continuous set, click on 

the first, hold down the Shift key, and click on the last. To select a discontinu-

ous set, hold down the Ctrl key as you click on items. Or, make no selection to 

edit all in a complete or filtered list of incidents. 

3. Select Actions > Edit. A Mass Update dialog opens. 

4. Do any of the following: 

• Select the status you want to assign to the selected incident in the Status list 

of values. (See page 4-1 for a discussion of status definitions.) 

• Write a comment in the Comments field. 

• Attach files to the incidents (see page 1-6). For a mass edit, you can attach 

only URLs. 

5. Click the Save, Save and Close, or Submit button. (Remember that a submission 

can alter the state of an incident, but a save cannot. See page 4-2.) 

Because the Manage Results home page displays pending incidents by default, inci-

dents disappear from its list if you select a status other than Assigned or Remedia-

tion, and submit the change. You can, however, search for incidents at other statuses. 
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Viewing and Editing Individual Incidents 

For each incident, you can open a page in which you can view its full details. Or, 

you can open an edit version of that page, in which you can set the incident’s status, 

attach files, add comments, and reassign the incident. (Any number of pages, each 

devoted to a distinct incident, may be open at once, but you must open them one at a 

time, to avoid triggering the mass-edit feature.) 

To open an incident in view mode, generate a list of incidents in the Manage Results 

home page (see “Viewing Controls or Incidents in Summary” on page 4-2), then 

click on the Result ID value for the incident you want to open. 

To open an incident in edit mode, do either of the following: 

• Open an incident in view mode, then select Actions > Edit Definition in the 

view page for that incident. 

• Generate a list of incidents in the Manage Results home page, click in the row 

for the incident you want to edit, and select Actions > Edit.  

Each view or edit page includes a Details panel, which displays the name, descrip-

tion, and priority of the control that generated the incident; the current incident sta-

tus and state; dates on which the control was last run and on which the incident was 

created and last updated; datasources on which the incident exists; and other details. 

Below the Details panel, a set of tabbed panels provides additional information: 

• Result Details defines the incident in question. The grid displays values for all 

attributes selected to characterize the suspect transaction. (These values were 

selected during configuration of the model that served as the basis of the control 

that generated the incident.) 

• Perspectives shows the perspective values and result investigators currently 

assigned to the incident. (Initially, these are determined by Results Management 

Perspective Assignment values selected for the control that generated the inci-

dent.) You can modify these values (see “Assigning Incidents,” below). 

• Comments displays the comments currently written for the incident, and enables 

you to create new comments.  

• Relationship Assignment lists associations currently configured between the 

incident and processes, other base objects, risks, or controls in the Financial 

Governance module or custom EGRCM modules. You can modify these values 

(see “Assigning Relationships,” page 4-6). 

To set status for the incident, open it in edit mode and select a new value in the 

Status LOV of the Details panel. (See page 4-1 for a discussion of status defini-

tions.) Click the Save button or the Submit button. (Remember that a submission 

can alter the state of an incident, but a save cannot. See page 4-2.) In the details 

panel, you can also attach files to the incident (see page 1-6). 

To create a new comment, open the incident in edit mode, click the comments, tab, 

and click the Add Comments button. An Add Comments pop-up window opens; 

type your comment and click the OK button. Then save the incident. 
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Assigning Incidents 

If you are the result investigator for an incident, you can assign the incident to 

another user. You can do this either from the Manage Results home page (in which 

case you can reassign any number of incidents at once) or from the edit page for an 

individual incident. Because eligible investigators are users whose roles specify 

perspective values that match those assigned to an incident, reassigning the incident 

may involve resetting the perspective values configured for the incident. 

To reassign incidents from the Manage Results home page: 

1. Generate a list of incidents in the Manage Results home page (see page 4-2). 

2. Select the incidents you want to reassign: To select a single incident, click on its 

row. To select a continuous set, click on the first, hold down the Shift key, and 

click on the last. To select a discontinuous set, hold the Ctrl key as you click on 

incidents. Or, make no selection to reassign all in a complete or filtered list of 

incidents. (You cannot reassign more than 1,000 incidents at a time.) 

3. Click on the Assign button. A Perspective Assignment pop-up window opens. 

4. Select perspective values to be added to, or removed from, those already chosen 

for each incident you are reassigning. (See “Selecting Perspectives,” page 1-3.) 

Select the Add or Remove radio button, then move the values to be added or 

removed from the Available Perspective Items list to the Selected Perspective 

Items list. If you are editing incidents with distinct sets of parameter values, you 

add or remove the same values to or from each set, but you add or remove only 

those values, and the sets remain distinct. 

5. In the Result Investigator field of the Worklist Assignment box, select a result 

investigator. 

• Select All Eligible Users to permit incident review by any user whose job 

roles specify data roles that specify perspective values that match those 

chosen for the incidents. (Incidents default to All Eligible Users if their 

original investigators are invalidated by your perspective selections.) 

• Select Search to appoint a single user for incident review. A Search and 

Select Investigator dialog opens. In it, enter text strings to match any 

combination of username, given name, and surname. (You can use the 

percent sign as a wild-card character.) Then select the user you want. 

By default, the Result Investigator field is blank; if you make no selection, each 

incident retains the result investigator originally assigned to it. If you make a 

selection, it applies to all the incidents you are editing. 

6. Click the Submit button 

To reassign an incident from its edit page: 

1. Open the edit page for the incident (see page 4-4). Select the Perspectives tab. 

2. Select perspective values for the incident. (See “Selecting Perspectives,” page 

1-3.) From the incident’s edit page, you edit perspective values; those remaining 

in the Selected Perspectives list are all the values that apply to the incident. 
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3. Select a result investigator in the Result Investigator field of the Worklist Assign-

ment box. As before, you can select all users whose roles specify perspective 

values that match those selected for the incident, or any one of those users. 

4. Click the Save button or the Submit button. (Remember that a submission can 

alter the state of an incident, but a save cannot. See page 4-2.) 

Assigning Relationships 

You can establish relationships between incidents in the CCM module and objects 

in EGRCM modules. Incidents may be related to processes, other base objects, risks, 

or controls, which may exist in the Financial Governance module or any custom 

module. Once a relationship is created, the incident is listed both in the CCM Manage 

Results page and in a Results tab of the Manage page for the EGRCM object to which 

the incident is related. 

From the Manage Results page, you can create relationships for any number of 

incidents at once. Or, from the edit page for an individual incident, you can create 

relationships for that incident. 

To create relationships from the Manage Results home page: 

1. Generate a list of incidents in the Manage Results home page (see page 4-2). 

2. Select a set of incidents. To select a single incident, click on its row. To select a 

continuous set, click on the first, hold down the Shift key, and click on the last. 

To select a discontinuous set, hold the Ctrl key as you click on incidents. Or, 

make no selection to modify relationships for all in a complete or filtered list of 

incidents. (You cannot reassign more than 1,000 incidents at a time.) 

3. Click on the Assign button. An Assignment pop-up window opens; select its 

Relationship Assignment tab. 

4. Select the Add radio button to add objects to those already chosen for each of 

the incidents you’ve selected. Or select the Remove radio button to remove 

objects from those already chosen. If you are editing incidents with distinct sets 

of relationships, you add or remove the same objects to or from each set, but 

you add or remove only those objects, and the sets remain distinct. 

5. Select Actions > Add, or click the green + button. A Search and Select window 

opens. 

6. In a Module field, select an EGRCM module. In an Object Type field, select a 

type of object within that module. Click the OK button. The Search and Select 

window expands to list objects of the type, and within the module, you specified. 

7. In that list, select objects with which you want to work. You can search for 

objects. Again, you may use the Ctrl or Shift key to select sets of objects, or 

make no selection to accept all in a complete or filtered list. 

8. Click the OK button. Objects you’ve selected then appear in the Related Objects 

grid of the Relationship Assignment window. 

9. If you determine you’ve added objects to the Related Objects grid erroneously, 

remove them: Select them and select Actions > Remove, or click the red × button. 

10. Click on the Submit button. 
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To configure relationships from the edit page for an incident: 

1. Open the edit page for an incident, and select the Relationship Assignment tab. 

2. Select Actions > Add, or click the green + button. A Search and Select window 

opens. 

3. In a Module field, select an EGRCM module. In an Object Type field, select a 

type of object within that module. Click the OK button. The Search and Select 

window expands to list objects of the type, and within the module, you specified. 

4. In that list, select objects with which you want to work. You can search for 

objects. You may use the Ctrl or Shift key to select sets of objects, or make no 

selection to accept all in a complete or filtered list. 

5. Click the OK button. Objects you’ve selected then appear in the Related Objects 

grid of the Relationship Assignment window. 

6. Click the Save button or the Submit button. (Remember that a submission can 

alter the state of an incident, but a save cannot. See page 4-2.) 

Contextual Reporting for Incident Results 

When you select Control Summary in the View By list box of the Manage Results 

home page, you can generate a Result by Control Summary Extract Report. It lists 

access and transaction controls that have generated pending incidents, and provides 

information about each control. 

When you select Incident Results in the View By list box of the Manage Results 

home page, you can generate the following transaction reports: 

• Result Summary Extract Report lists incidents generated by access and transac-

tion controls, providing summary details for each. 

• Transaction Incident Details Extract Report lists incidents generated by a 

transaction control. It provides not only the information that would be included 

in the Result Summary Extract Report, but also values for all attributes selected 

to characterize suspect transactions. These attributes vary from one control to 

another, so each run of the report must focus on a single control. 

To run a report: 

1. Generate a list of controls or a list of incidents in the Manage Results home 

page (see page 4-2). 

2. Filter the list to include only the controls or incidents about which you want the 

report to display information — for example, a list of controls at a particular 

priority or a list of incidents at a particular status. If you do not filter the list, the 

report contains either all controls or all pending incidents to which your roles 

give you access. (For information on filtering, see “Searching Among Records” 

in the GRC User Guide.) 

Some incident reports are specific to access or transaction incidents (or con-

trols), and others are general. GRC automatically filters by type as needed: An 

access-specific report includes information only about access controls or inci-

dents, a transaction-specific report includes information only about transaction 

controls or incidents, and a general report includes information about both. 
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3. In the Report list box, click on the report you want to run. 

4. In the list box immediately to the right of the Report list box, click on the 

format in which you want to produce the report. If the report has the word 

Extract in its name, you can select only the value csv; this produces a file 

designed for export to another application, such as a spreadsheet, for further 

manipulation. For all other reports, you may choose csv or pdf; the latter 

produces a formatted report that can be viewed in Adobe Acrobat. 

5. Click on the Print button. An Information pop-up window opens, identifying a 

job number. Note the number, then close the window (click on its OK button). 

6. Using the Navigator, go to Tools > Setup and Administration > Manage Jobs. In 

the Manage Jobs page, locate the row displaying the job ID you noted in step 5. 

When its Message cell displays a Job Completed link, click on the link. 

7. A Job Detail window opens. In it, click on the Item Results link. 

8. A file-download window offers you options to open or save the report. The 

precise behavior of this window depends on the web browser you use. In gen-

eral, if you choose to save, select the Save option. In a distinct save-as dialog, 

navigate to the folder in which you want to save the file.  

9. Close the Job Detail window (click on its OK button). 


	Preface
	Introduction
	ETCG Models and Controls
	Incident Analysis
	Reporting
	Common Procedures
	Selecting Perspectives
	Synchronizing Data
	Attaching Files
	Importing and Exporting Models and Controls


	Creating and Managing Models
	Managing Models
	Viewing Models
	Creating, Editing, Copying, or Deleting Models
	Model-Data Synchronization

	Creating a Transaction Model
	Naming the Model
	Choosing Whether to Limit Analysis Time
	Selecting Business Objects
	Using Custom Objects
	Selecting Datasources
	Arranging Filters, Functions, and Patterns
	Creating a Standard Filter
	Using Filters That Return Sets of Values
	Creating a Function
	Creating a Pattern
	Defining Model Results
	Saving the Model

	Viewing or Exporting Model Results

	Creating and Managing Continuous Controls
	Creating Transaction Controls
	Naming and Describing Controls
	Setting Priority, Status, and Result Type
	Selecting Datasources
	Selecting Perspective Values and Result Investigators
	Writing Comments

	Mass-Editing Controls
	Viewing and Editing Individual Controls
	Running Controls
	Contextual Reporting for Controls
	Managing User Defined Objects

	Resolving Incidents
	Viewing Controls or Incidents in Summary
	Mass-Editing Incidents
	Viewing and Editing Individual Incidents
	Assigning Incidents
	Assigning Relationships
	Contextual Reporting for Incident Results


